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ABSTRACT 

Hydrological data are typically sequential and often correspond to large datasets, and not 
all application programs allow their retrieval, storage, and manipulation. This technical 
article aims to contribute to this subject by reporting the applicability of the Data Storage 
System of the Hydrologic Engineering Center (HEC-DSSVue) using 5-min rainfall 
datasets collected from 10 self-recording rain gages (2014–2023) installed in Southern 
Brazil. Although the HEC-DSSVue is commonly used to integrate databases into other 
HEC models (HEC-HMS and HEC-RAS), its application in managing hydrological 
gaging networks remains undocumented. Our methodology comprised six steps 
conducted within the HEC-DSSVue: i) acquiring all files generated from each 
hydrological campaign, ii) addressing irregular-interval time series, iii) evaluating file 
management functionalities, iv) identifying data visualization functionalities, v) assessing 
mathematical operations, and vi) examining edition and export functions. The main 
conclusion was that the HEC-DSSVue is a powerful tool for efficiently managing datasets 
from hydrological gage networks and supporting data manipulation, thereby making 
routine tasks more efficient and less susceptible to user-introduced errors. 

 
INTRODUCTION 

Hydrological gaging provides critical information on 
hydrometeorological variables gathered from gaging 
stations. These data are essential for understanding the 
hydrological behavior of watersheds and for effective water 
resource management. Gaging stations can be categorized 
as conventional, automatic, and telemetric stations based on 
their data gathering, recording, and transmission 
mechanisms. Conventional stations require manual data 
collection by observers at predefined intervals, whereas 
automatic stations rely on data loggers to store information 
with periodic uploads depending on the capacity of the data 
logger. Conversely, telemetric stations are equipped with 
data loggers that store and transmit data in different ways 
(GPRS and satellites), enabling real-time hydrological 
gaging. Each type of gaging station produces data in a 
unique output format, necessitating distinct techniques for 

data acquisition and manipulation, particularly in 
hydrological gaging networks with diverse station types. 

Hydrological gaging networks generate vast 
amounts of data, making manual operations impractical 
because of the frequent need for complex mathematical and 
statistical analyses. Although general-purpose computer 
programs, such as spreadsheets, are commonly used, these 
tools have significant limitations, as they are not 
specifically idealized for hydrometeorological datasets. The 
key challenges include i) individualized data manipulation 
for each gaging station owing to output format variability, 
ii) difficulties in handling date and time data, iii) lack of 
tools for irregular-interval time series, iv) absence of 
visualization tools tailored to hydrological data, v) 
increased risk of user errors, vi) difficulties in managing 
time series gaps, vii) difficulties in aggregating data at 
different time intervals, and viii) a limited range of 
operations intrinsic to hydrological analysis. 
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Several computer programs have been developed 
exclusively for hydrological analysis, including HIDRO 
(ANA, 2002), SisCAH (UFV, 2008), ALEA (UFMG, 
2012), SEAF (Cândido, 2003), Hydrognomon (Kozanis et 
al., 2010), SYHDA (Vargas et al., 2019), and GAM-IDF 
(Vargas et al., 2023). Although these tools offer valuable 
functionalities, they often have limitations, as they are 
tailored for specific file formats, time intervals, or a 
restricted set of analyses. Consequently, none of these tools 
were inherently conceived for the comprehensive 
management of hydrological gaging networks. 

The Data Storage System of the Hydrologic 
Engineering Center (HEC-DSS), which is linked to the US 
Army Corps of Engineers, is a computer program 
specifically designed to manipulate hydrometeorological 
datasets stored in various file formats. According to 
USACE (2024), the HEC-DSS is a database system capable 
of storing, managing, and retrieving sequential records, 
such as time series derived from hydrological gaging 
networks and paired datasets. The HEC-DSS can be used to 
transfer hydrological datasets to other HEC tools such as 
HEC-HMS, HEC-RAS, and HEC-MetVue, which are 
applied worldwide. The Data Storage System Visual Utility 
Engine (HEC-DSSVue) developed by HEC serves as a 
graphical interface based on the Java programming 
language and is compatible with Windows, Linux, and 
MacOS (USACE, 2024). HEC-DSSVue allows users to 
import, tabulate, edit, manipulate, plot, and export datasets 
in the DSS format. In addition, it has over 60 mathematical 
functions organized into the following categories: 
arithmetic, general, time, hydrological, smoothing, and 
statistical. An important advantage of HEC-DSSVue is its 
ability to standardize and streamline repetitive tasks related 
to data manipulation, thereby reducing the possibility of 
user error. It also provides a framework for the consistent 
application of hydrological procedures. 

Despite its potential, no publications were found in 
Brazil or internationally that focused on assessing HEC-
DSSVue for managing hydrological gaging networks. 
However, some studies used the HEC-DSSVue to process 
data for integration with other HEC tools (Bielenki Júnior 
et al., 2016; Fuaad & Mustafa, 2019). For example, Bielenki 
Júnior et al. (2016) used the HEC-DSSVue in Brazil to 
manipulate rainfall datasets and input them into HEC-SSP. 
Similarly, Fuaad & Mustafa (2019) applied the HEC-
DSSVue to Iraq to manipulate streamflow records and 
derived time series with different time intervals for use in 
other HEC models. 

The Research Group on Hydrology and 
Hydrological Modeling in Watersheds (RG Hydrology) 
manages two hydrological gaging networks, including 

rainfall and other meteorological data as well as stage and 
streamflow measurement data for watercourses. The main 
objective of this study was to evaluate the applicability of 
the HEC-DSSVue for storing, managing, and manipulating 
rainfall datasets collected from a hydrological gaging 
network installed in the Pelotas River watershed (PRW). 
Notably, this study is the first to compare the HEC-DSSVue 
with widely used spreadsheets from the perspective of 
managing hydrological gaging networks. These findings 
provide valuable insights for hydrologists and engineers and 
contribute to the advancement of data management 
practices in hydrology. 

CASE STUDY: HYDROLOGICAL GAGING 
NETWORK IN SOUTHERN BRAZIL  

The RG Hydrology operates a hydrological gaging 
network in the PRW, which comprises many gaging stations 
installed in the drainage area upstream of the Cordeiro de 
Farias Bridge (PRW-CFB), as illustrated in Figure 1. The 
municipalities of Pelotas, Canguçu, and Morro Redondo, 
situated in Rio Grande do Sul State, Southern Brazil, lie 
partially within this drainage area, amounting to 386 km² 
(Figure 1). The RG Hydrology is responsible for the 
acquisition, storage, and management of rainfall datasets 
collected using self-recording rain gages installed in the 
PRW-CFB. 

Rainfall datasets from 10 self-recording rain gages 
(model HOBO-RG3-M) that have been in operation since 
2014 (Figure 1) were used in this study. These rain gages 
are installed 1.5 m above the ground and are protected by 
surrounding fences. This gage is constructed of aluminum 
and operates according to the tipping bucket principle, such 
that each bucket tip represents a rainfall depth of 0.2 mm. 
The equipment is 15.25 cm in diameter and 25.72 cm in 
height, and weighs 1.2 kg. Each gage is powered by an 
internal lithium battery placed along with its data logger. Its 
operating principle is to automatically store date and time 
stamps whenever a 0.2 mm bucket tip occurs, allowing the 
determination of rainfall intensities and duration. With a 
storage capacity of 64 kB, the data logger can hold 25,000–
30,000 recorded tips. The rain gages used in the PRW-CFB 
were programmed to record cumulative rainfall depths 
every 5 min. Considering the aforementioned configuration 
and the data logger’s capacity, data acquisition can typically 
be performed once every three months using the 
HOBOWare software. Although these rain gages are 
automatic, they do not provide real-time tele-transmission 
data. Consequently, members of the RG Hydrology conduct 
field campaigns every two months for data acquisition and 
maintenance of the hydrological gaging network.
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FIGURE 1. Location of the automatic rain gages in the hydrological gaging network situated in the PRW.  
 
HOW WAS THE HEC-DSSVUE APPLICABILITY 
TESTED WITH RESPECT TO MANAGEMENT OF 
RAINFALL DATASETS DERIVED FROM A 
HYDROLOGICAL GAGING NETWORK? 

The methodology of this study consisted of six steps 
developed entirely within the HEC-DSSVue environment: 
1) data acquisition considering all the files generated after 
each hydrological campaign, 2) handling of irregular-
interval time series, 3) evaluation of functionalities for file 
management, 4) identification of data visualization 
functionalities, 5) assessment of available mathematical 
operations, and 6) evaluation of edition and export 
functions. For this purpose, datasets with rainfall depths 
from 2014 to 2023, including regular- and irregular-interval 
records, were used. 

Step 1 involved acquiring records from all files 
originated from the hydrological campaigns for the rain 
gages, which were stored in the RP Hydrology cloud 
(HOBOware format). Subsequently, these files were 
opened in HOBOware software, the manufacturer of the 
rain gages used in this study, and converted into a format 
compatible with spreadsheets (.csv). Finally, the csv files 

were imported into the HEC-DSSVue as Pathnames using 
the “Data Entry → Manual Time Series” function. In the 
HEC-DSSVue, each imported file is assigned a Pathname, 
which comprises six Parts: 

 A-Part: defines the project, river, or watershed 
name; 

 B-Part: informs the location of the gage providing 
the records; 

 C-Part: corresponds to the data parameter; 

 D-Part: stores the starting date of the records; 

 E-Part: refers to the time interval in which records 
are organized; 

 F-Part: allows users to include additional 
descriptive information. 

Step 2 focuses on identifying a set of operations 
available in HEC-DSSVue capable of dealing with 
irregular-interval time series data, that is, when records are 
not organized according to a unique time interval. Irregular-
interval records may arise because of issues associated with 
critically low battery levels in the data loggers, failure at the 
moment of recording readings, or errors in the definition of 
the time interval when reprogramming the data logger. 
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In Step 3, the functions in the Edit menu are analyzed 
to assess essential file management operations; the main 
goal of this step is to standardize datasets and files. The 
Merge function was carefully evaluated as it enables the 
placement of multiple individual Pathnames into a single 
continuous time series with records between 2014 and 2023. 
Step 4 corresponds to the appraisal of some data 
visualization functionalities within the Display menu for 
exploratory hydrological analysis. In this menu, “Tabulate” 
and “Plot” were explored for their ability to display data in 
tables and graphs. In Step 5, some mathematical functions 
available in the HEC-DSSVue (accessible via Tools → 
Math Functions) are analyzed. The goal was to verify their 
applicability to data handling and management, as well as 
their advantages over spreadsheet-based methods.  

The assessment of tools designed for editing and 
exporting graphs and tables, enabling the visualization of a 
complete series for each rain gage or even for all rain gages, 
is addressed in Step 6. For this purpose, we created and 
exported pluviograph- and hyetograph-type graphs for the 
complete series (2014 to 2023), both individually for each 
rain gage and together for all rain gages. This 
methodological framework offers a comprehensive 
assessment of the capabilities of the HEC-DSSVue in 
managing rainfall datasets gathered from hydrological 
gaging networks. 

ANALYSIS, FINDINGS, AND INSIGHTS 
RESULTING FROM THE EVALUATION OF THE 
HEC-DSSVue APPLICABILITY FOR THE CASE 
STUDY 

Data acquisition, file import to the HEC-DSSVue, and 
its data management philosophy using Pathnames 

We manually imported 508 raw files in CSV (10 rain 
gages named P-01 through P-10) resulting from field 
campaigns conducted between 2014 and 2023 into the 
HEC-DSSVue. To ensure standardized file management, 
the Pathnames representing the files resulting from each 
hydrological campaign were individually parameterized by 
populating Parts A, B, C, D, E, and F, such that the same 
procedure was adopted for the other nine rain gages. The 
first advantage of the HEC-DSSVue over the other tools lies 
in its ability to import files containing rainfall data directly 
from the rain gages used in this study. The files used in this 
study had a specific format generated by HOBO automatic 
rain gages. Other hydrology computer programs, such as 
HIDRO (ANA, 2002), SYHDA (Vargas et al., 2019), 
GAM-IDF (Vargas et al., 2023), ALEA, and SisCAH 
(UFV, 2008), do not support the direct import of the 
analyzed files. Many of these tools were primarily designed 
to deal with daily Brazilian databases from ANA and/or 
INMET. For example, SYHDA (Vargas et al., 2019) and 
GAM-IDF (Vargas et al., 2023) allow imports in a columnar 
text format with data preprocessed into daily intervals. 

After importing all the files, we verified an important 
advantage of the HEC-DSSVue: its ability to standardize 

data storage using Pathnames. This implies that the HEC-
DSSVue project file (.dss) may have a unique Pathname or 
even thousands of Pathnames. In practice, a Pathname 
represents a dataset of rainfall depth records obtained from 
a specific rain gage over a given time window. In other 
words, the definition of Pathnames in Parts enables 
hydrologists to provide an excellent data management 
strategy and promising alternatives from the hydrology 
perspective of grouping and analyses. This logic is not used 
in the other hydrology tools mentioned in the article: 
HIDRO (ANA, 2002), SisCAH (UFV, 2008), ALEA 
(UFMG, 2012), SEAF (Cândido, 2003), Hydrognomon 
(Kozanis et al., 2010), SYHDA (Vargas et al., 2019) and 
GAM-IDF (Vargas et al., 2023). This is because these tools 
were not developed for the management of hydrological 
databases but rather for specific hydrological analyses. 

The highest level of the HEC-DSSVue Pathname in 
the context of a hierarchical window is defined as A-Part. 
We defined A-Part as the watershed where the hydrological 
gaging network was installed (PRW) because the RG 
Hydrology manages datasets from different watersheds. 
Datasets from 10 self-recording rain gages installed within 
this watershed were evaluated; therefore, “Pelotas River” 
was informed in A-Part. When considering the rain gage 
datasets from different watersheds, the hydrologist would 
simply need to change the name in A-Part, thus 
considerably facilitating the Pathnames management. The 
logic behind B-Part, the second management level, was to 
name it according to the rain gage ID. Under the 
management viewpoint, all the rainfall depth records with 
B-Part defined as P-01 through P-10 are linked to A-Part 
(“Pelotas River”). 

A-Part and B-Part were conceived in the HEC-
DSSVue to organize and manage the datasets. When 
comparing the HEC-DSSVue file management system with 
spreadsheets, A-Part would probably be a folder 
corresponding to the hydrological gaging network, whereas 
B-Part would potentially resemble the file associated with 
each gaging station, containing different sheets populated 
with data for specific time periods. In this study, there 
would be a folder with 10 spreadsheet files, each containing 
several sheets, totaling 508 sheets to be managed. Managing 
this large number of spreadsheets is challenging, 
particularly considering that the datasets could come from 
various rain gages and have different time windows, 
varying time intervals, and potential gaps. Figure 2 
illustrates the organization of Pathnames in the HEC-
DSSVue Catalog, using P-02 as an example. In this study, 
we created a separate dss file for each rain gage; however, 
it would be simpler to manage the Pathnames of all rain 
gages in the same dss file. If a dss file is created for each 
rain gage, the HEC-DSSVue offers a key feature that allows 
modelers to keep multiple projects open simultaneously, 
enabling them to drag Pathnames of interest from one dss 
project to others.
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FIGURE 2. Illustration of the Pathnames organization in the HEC-DSSVue, using the datasets of P-02 as a reference, along with 
a representation of irregular-interval time series. 

 
C-Part plays a fundamental role in defining the 

hydrological variable which will have records stored and 
analyzed. Almost 100 hydrological, meteorological, and 
land-use variables are available for use in the HEC-DSSVue 
(https://www.hec.usace.army.mil/confluence/hmsdocs/hms
um/latest/data-storage-in-hec-dss/descriptors). The other 
hydrology tools listed in this article, namely HIDRO (ANA, 
2002), SisCAH (UFV, 2008), ALEA (UFMG, 2012), SEAF 
(Cândido, 2003), Hydrognomon (Kozanis et al., 2010), 
SYHDA (Vargas et al., 2019), and GAM-IDF (Vargas et al., 
2023), allow users to deal with information of a much more 
limited number of variables (generally, only incremental 
rainfall and instantaneous streamflow). This suggests that 
the HEC-DSSVue offers greater flexibility for hydrological 
data manipulation and analysis. Furthermore, C-Part 
enables modelers to specify the hydrological meaning 
behind the stored records. In this study, all Pathnames were 
defined as PRECIP-INC. Therefore, it is expected that the 
datasets added to the respective Pathname correspond to the 
incremental rainfall depth, that is, the rainfall depth 
occurring within each predefined time interval. Graphically, 
these data over time represent a hyetograph. Notably, 
PRECIP-CUM can be used in C-Part rather than PRECIP-
INC, corresponding to the cumulative rainfall depth over 
time (graphically, a pluviograph). It is also essential to 
discuss the data type in which the datasets are stored, as 
specified during the creation of a Pathname. The HEC-
DSSVue data types were classified as PER-CUM, PER-
AVER, INST-VAL, and INST-CUM, referring to the period 
cumulative, period average, instantaneous value, and 
instantaneous cumulative, respectively. The incremental 
rainfall depth is defined as PER-CUM, as this variable 
represents the cumulative rainfall depth within a time 
period. Notably, the correct operation of several HEC-
DSSVue functions depends on the appropriate definition of 
the data type. Because the computer programs used for 
comparison in this study were generally designed to handle 
specific Brazilian databases (HIDRO, SYHDA, and GAM-
IDF), and not files directly generated by rain gages, these 
programs only work with incremental rainfall depths 
corresponding to the PRECIP-INC variable and PER-CUM 
data type in the context of the HEC-DSSVue. 

D-Part refers to the date and time of the first record 
of the Pathname. This is crucial for organizations, because 
it enables users to split a full hydrological series into several 
subsets for specific periods. Once a Pathname (manual or 
import) has been created, users can view the start and end 

dates of the Pathname in Part-D, making it easier for them 
to rapidly identify and manage different datasets in the 
Catalog. The HEC-DSSVue requires a nine-character 
military-style date. 

E-Part is also key in the HEC-DSSVue, as it 
represents the time interval between two consecutive 
records of the variable being analyzed (incremental rainfall 
in the present study). During the creation of a Pathname 
using either manual inclusion or automatic import, the 
HEC-DSSVue determines whether the time interval is 
constant throughout the records in the dataset. If the HEC-
DSSVue identifies that the time interval is not constant, it 
designates E-Part as IR (irregular) (Figure 2). The ability to 
handle regular and irregular time intervals makes the HEC-
DSSVue highly applicable in hydrological engineering. 
Another strength of the HEC-DSSVue is its capability to 
work with time intervals shorter than one day (e.g., 1 h, 30 
min, and 5 min), providing numerous functions to 
manipulate datasets under these circumstances. In contrast, 
most hydrological tools are designed to handle only daily 
datasets, such as HIDRO (ANA, 2002), SYHDA (Vargas et 
al., 2019) and GAM-IDF (Vargas et al., 2023), further 
reinforcing the applicability of the HEC-DSSVue in 
everyday hydrological applications. 

Despite the large number of csv-format files 
imported into the HEC-DSSVue, we observed the 
advantages of manual import, particularly in cases where 
the datasets had regular time intervals. Two points of 
discussion on file imports are pertinent. First, the HEC-
DSSVue enables automatic import using functions that 
support general format files (e.g., xlsx, csv, and txt) and 
other specific databases that are not applicable to our study 
(e.g., USGS and SHEF). Notably, automatic import 
functions for the csv and txt files were not assessed in this 
study. Second, each csv file from every rain gage for each 
hydrological campaign was individually imported into the 
HEC-DSSVue, resulting in a separate Pathname for each 
file. This procedure led to the creation of numerous 
Pathnames. For illustrative purposes, each Pathname was 
used to store rainfall depth records from a rain gage for 
periods between 1 and 15 weeks.  

For future studies related to HEC-DSSVue for 
similar purposes, we recommend merging all csv files 
containing datasets from the same rain gage and importing 
only one file with its complete historical series into the 
program. This approach would be highly advantageous, 
particularly when hydrologists need to manage numerous 
rain gages or multiple gaging networks. 
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Dealing with regular- and irregular-interval time series 
in the HEC-DSSVue 

After importing a file obtained from a self-recording 
rain gage and creating the corresponding Pathname, the 
dataset was expected to be temporally organized according 
to a predefined time interval. The HEC-DSSVue confirms 
this organization and automatically populates the E-Part of 
the Pathname accordingly. When the software recognizes 
that the records are organized in a unique time interval, it 
populates the E-Part accordingly (from 1 min to 1 year). 
Conversely, if it detects the occurrence of multiple time 
intervals, “IR” (irregular time interval) is added to the E-
Part. In the case of an irregular time interval, the datasets 
are stored in variable-length blocks (e.g., days, months, 
years, decades, or centuries). In some cases, we noticed that 
the rainfall datasets were stored following irregular time 
intervals, that is, without a constant time interval between 
two consecutive rainfall depth records. In these cases, the 
E-Part was populated with “IR-MONTH” (Figure 3). From 
a hydrological perspective, the nonuniformity of time 
intervals may poses challenges in organizing historical series, 
performing hydrological analyses, and preparing inputs for 
hydrological models. Therefore, we evaluated the HEC-
DSSVue functions for handling irregular time intervals.  

Initially, we sought to comprehend how records 
were stored when the HEC-DSSVue identified them as 
being organized according to an irregular time interval. In 
these cases, the rain gage data logger only recorded the 
exact moments when the tipping bucket tipped, storing the 
cumulative rainfall depth over time instead of aggregating 
the incremental rainfall within predefined time intervals. 
Two alterations were applied to address this issue: i) 
replacement of “PRECIP-INC” with “PRECIP-CUM” in 
the C-Part using the Rename Records function (menu 
Edit), and ii) change in the data type from “PER-CUM” to 

“INST-CUM” (instantaneous cumulative rainfall), 
directly through Tabulate or the Set Type function (Math 
Functions → General). 

After editing C-Part and E-Part for each Pathname 
initially identified with irregular time intervals, we 
evaluated the applicability of the Irregular to Regular 
function. This function, available under Tools → Math 
Functions -> Time Functions -> Irregular to Regular, is 
intended for the transformation of an irregular-interval into a 
regular-interval time series and can be applied in two ways: 

 Interpolation (fill-in values): This process creates 
a new regular-interval time series. 

 Snap (no fill-in values): This derives a new regular-
interval time series by moving data in accordance 
with the user-specified regular-interval time.  

Some arguments can be made when configuring this 
function for both options (interpolation or snap), thereby 
broadening its applications in the field of hydrology. For 
this study, we selected Snap because it was better suited to 
the datasets of the present study. This procedure resulted in 
a Pathname storing cumulative rainfall depths. The next 
step was to create a Pathname compatible with the 
incremental rainfall depths. We investigated the operators 
existing in the “Arithmetic” tab (Tools → Math Function → 
Arithmetic). Among them, the Successive Differences 
operator has the necessary characteristics; that is, it 
computes the difference between two consecutive records 
and enables either updating the Pathname or creating 
another Pathname with the transformed data. After 
applying this function, HEC-DSSVue updated the data type 
to “PER-CUM,” i.e. incremental rainfall depth per time 
interval (5 min in this case), representing the dataset as a 5-
min time interval hyetograph (Figure 3).

 

 

FIGURE 3. Demonstration of the “Irregular to Regular” and “Successive Differences” functions for P-02. 
 

The transformation of an irregular-interval time 
series into a regular-interval time series is highly complex 
and often unfeasible when performed within spreadsheets 
given their inherent limitations. Obviously, other computer 
tools make it possible to manipulate irregular-interval 
records using automatic procedures; nevertheless, they 
demand that users have minimal programming language 
skills. For readers interested in programming solutions, R 
and Python have excellent packages with functions that are 
appropriate for working at regular and irregular time 
intervals. The HEC-DSSVue provides a user-friendly and 
intuitive interface specifically tailored for hydrological data 
manipulation. This tool was designed to comprehend 
hydrological time series, and has specific functions for 
dealing with hydrological issues without necessarily 

requiring programming expertise. In Figure 3, we 
demonstrate the conversion of an irregular dataset obtained 
from P-02 containing records from September 12, 2014, to 
September 13, 2014. Although the time period used was 
short, this example highlights the importance of the 
continuous representation of rainfall depths over time. Such 
a representation is possible only because of the conversion 
of irregular -interval records into regular-interval records.  

From a hydrological perspective, the example 
illustrated in Figure 3 represents a classic scenario. Users 
are frequently confused by the fact that, depending on the 
organization of rainfall records, they may seem to indicate 
some missing values instead of no rainfall in the determined 
time intervals. This task would have been practically 
impossible to perform using spreadsheets, and the 
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hydrology tools mentioned in this article do not provide 
functionalities for dealing with irregular-interval 
hydrological datasets. For instance, the tools described in 
UFV (2008), Cândido (2003), Vargas et al. (2019), and 
Vargas et al. (2023) cannot process irregular-interval 
records because they were primarily designed to work with 
national hydrological databases such as those from ANA, 
which consist exclusively of regular-interval data. 

Exploring HEC-DSSVue functionalities for grouping 
datasets 

All the Pathnames corresponding to each rain gage 
were merged into a single Pathname applying the “Merge 
Time Series” function. Practically, the 76 Pathnames 
initially created for P-01 with records from 2014 to 2023 
were grouped into one Pathname. The same procedure was 
applied to other rain gages. This function was useful for 
merging all datasets in the HEC-DSSVue, allowing for 
more efficient file management, particularly when they 
were intended to be used in conjunction with hydrological 
models. In terms of data manipulation and consistency 
analysis, users can identify rainfall depth records in a time 
series with incorrect values by assessing all the 
hyetographs. For instance, a 5-min rainfall depth of 100 mm 
for a given rain gage, whereas the other time intervals are 
populated with no rain or with too low depths, can be 
flagged as an anomaly. Discrepant values were visually 
identified using hyetographs. In contrast, the use of 
spreadsheets makes it difficult to search for discrepant 
values in numerous rows and columns.  

Hydrologists frequently aggregate hydrological time 
series data into different time intervals for various purposes. 
It should be emphasized that transforming a time series into 
different time intervals requires the original time series to 
be organized with a regular time interval. Although this task 
may seem straightforward, it can be time-consuming if an 
adequate tool is not used. The HEC-DSSVue has an 
interesting operator: Change Time Interval -, under Math 
Functions → Time Functions. According to USACE (2024), 
the data type assigned to the Pathname (INST-VALUE, 
INST-CUM, PER-AVER, or PER-CUM) dictates the 
application of interpolation or extraction. Considering that 
the data type in Pathnames for this study was set as PER-
CUM, the Change Time Interval function computed the 
cumulative rainfall value for the new time interval 
(USACE, 2024). This task has been recurrent for 
hydrological studies. For example, after merging all the 
Pathnames created for a specific rain gage into one 
Pathname containing the complete 5-min rainfall depth 
time series, we may need to transform this time series to a 
different time interval, such as 1 h, for input into a 
hydrological model. This example highlights the 
applicability of the Change Time Interval function. Among 
the hydrological tools mentioned, SYHDA (Vargas et al., 
2019) offers the capability of transforming records from one 
time interval to another. However, its minimum supported 
interval is 1 day, which limits its use in studies requiring 
finer temporal resolutions. 

Exploring data visualization functionalities in HEC-
DSSVue 

Many data visualization functions grouped under the 
Display menu are available in the software. In this study, we 
focused on evaluating the applicability of Tabulate and Plot 
functions, which can be used to tabulate and plot records 
from one Pathname or multiple Pathnames simultaneously.  

For example, consider the complete rainfall time 
series obtained after merging several Pathnames, as 
described in Section Exploring HEC-DSSVue 
functionalities for grouping datasets, for the rain gages 
named P-01, P-03, P-04, and P-06. When the Pathnames of 
interest are selected in the HEC-DSSVue Catalog, the 
Tabulate function enables viewing and editing of all the 
corresponding datasets in a vertical scrolling window 
(USACE, 2024). These records were chronologically 
organized using a date and time stamp along with the 
measurement unit and data type (Figure 4). This is a 
significant advantage, as modelers can visually compare all 
selected datasets over time with respect to missing values, 
magnitude, and seasonality. This function allows the 
tabulation of datasets characterized by different time 
intervals and data types, aligning them along the same date 
and time columns. For instance, rainfall and streamflow 
datasets with different time intervals and periods can be 
tabulated together, and the HEC-DSSVue can distribute 
records over date and time accordingly. This capability of 
the HEC-DSSVue is incomparable to spreadsheet software 
and the previously mentioned hydrology tools (ANA, 2002; 
UFV, 2008; UFMG, 2012; Cândido, 2003; Kozanis et al., 
2010; Vargas et al., 2019; Vargas et al., 2023) with respect to 
data visualization and management, making it an excellent 
option for hydrological analyses from a regional perspective.  

In addition to tabulating the records, datasets can be 
visualized as plots. In this case, if the modeler selects the 
Pathnames of interest in the HEC-DSSVue Catalog, the 
Plot function allows users to view the data in a plot format 
(USACE, 2024). The strengths of the HEC-DSSVue with 
respect to the Plot function are as follows:  

 The HEC-DSSVue automatically creates a 
viewport for each data parameter (C-Part) and 
measurement unit identified among the selected 
Pathnames, plotting all datasets (Pathnames) with 
the same variable (C-Part) and an identical 
measurement unit in the same viewport. 

 The software allows users to arrange several 
viewports together, thereby facilitating the 
simultaneous visualization of rainfall and 
streamflow datasets.  

 Users can define a time window for plotting 
records from a given set of Pathnames, meaning 
that they are not required to plot the complete time 
series contained in the selected Pathnames. 

 Plot properties generated by the HEC-DSSVue are 
highly customizable.  

For illustration, by selecting the Pathnames 
indicated in Figure 4 and using the Plot function, the HEC-
DSSVue generates a graph displaying rainfall data from all 
the selected Pathnames. Because these Pathnames store 
incremental rainfall depths (defined as PRECIP-INC in C-
Part) in millimeters, the HEC-DSSVue automatically 
creates a hyetograph-type graph (stepped-type line). The 
HEC-DSSVue ensures that some plot properties vary based 
on the C-Part established in Pathname. A hyetograph-type 
graph was generated because C-Part was set as PRECIP-
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INC and the HEC-DSSVue had a stepped-type line defined 
as the default line style for this hydrological variable 
(Figure 4). An impressive characteristic of the HEC-
DSSVue is that it allows users to redefine the line style for 
the variable of interest (C-Part). The strengths associated 

with data plotting make the HEC-DSSVue a valuable 
supplementary tool compared to the application programs 
described by ANA (2002), UFV (2008), UFMG (2012), 
Cândido (2003), Kozanis et al. (2010), Vargas et al. (2019), 
and Vargas et al. (2023).

 

 

FIGURE 4. Visualization of tabular and plot data from the datasets derived from P-01, P-03, P-04, and P-06. 
 
Applicability of some HEC-DSSVue mathematical 
functions  

The strengths of the HEC-DSSVue for data 
manipulation using its mathematical functions Tools → 
Math Functions, were demonstrated based on the time series 
derived from the series-grouping step. The HEC-DSSVue 
comprises over 60 mathematical functions grouped by 
similarity and purpose in the following tabs: Arithmetic, 
General, Time Functions, Hydrologic, Smoothing, and 
Statistics. We assessed only the functions available in the 
Arithmetic, General, and Time Functions tabs because the 
functions in the Hydrologic and Smoothing tabs were 
beyond the scope of this study. 

The Arithmetic tab has general functions capable of 
adding, subtracting, multiplying, and dividing, either with a 
constant or a dataset, as well as several important 
functionalities whose applications are intrinsic to rainfall 
data manipulation for regular- and irregular-interval time 
series. These include Accumulation, Successive 

Differences, and Time Derivative. The Accumulation 
operator can be used to convert rainfall depth records 
organized in increments (incremental rainfall) into 
accumulated rainfall depths; this function allows 
hydrologists to transform a hyetograph into a pluviograph. 
The reverse procedure can be performed through the 
Successive Differences operator, which results in an output 
dataset with the “PER-CUM” data type if the original 
dataset is defined as the “INST-CUM” data type. Finally, 
the Time Derivative operator calculates successive 
differences per unit of time. When considering rainfall 
depth per time interval (Successive Differences), the use of 
the Time Derivative operator returns the average rainfall 
intensity per time interval, characterized by “PER-AVER” 
data type. Some of these functions were used in Section 
Dealing with regular- and irregular-interval time series in 
the HEC-DSSVue for dealing with irregular-interval time 
series. The use of these important functionalities in a 
hydrological context is illustrated in Figure 5.
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FIGURE 5. Using tabular data and plotting to visualize accumulated rainfall depths in millimeters (derived from the 
Accumulation function) and rainfall intensities in millimeters per minute (derived from the Time Derivative function) obtained 
from incremental rainfall depths in millimeters (hyetograph) observed for P-02. 

 
The General tab includes several useful operators 

such as Units Conversion, Set Units, Set Type, Round to 
Nearest Whole Number, Truncate to Whole Number, Round 
Off, Estimate Missing Values, Replace Specific Values, 
Screen Using Maximum and Minimum, Screen Using 
Forward Moving Average, Merge Time Series, Merge 
Paired Data, and Generate Data Pairs. Two operators were 
used in this study: Set Type and Merge Time Series. The Set 
Type operator modifies the data type defined in the 
Pathname (PER-AVER, PER-CUM, INST-VAL, or INST-
CUM). According to USACE (2024), this function was not 
designed to convert data to a newly defined data type; 
instead, it changes the data type label when the datasets 
(Pathnames) are incorrectly labeled. This occasionally 
occurred in this study, primarily after applying functions that 
generated new Pathnames. Users can identify the data type 
defined for each Pathname directly in the tabular data, as 
illustrated in Figure 4 (see the second row in the table derived 
from the Tabulate function), or directly in the form presented 
after accessing the Set Type function. The Merge Time Series 
function is widely used and is discussed in Section Exploring 
HEC-DSSVue functionalities for grouping datasets. 

The following functions are available in the Time 
function tab: Min/Max/Avg… Over Period, Copy in Time, 
Shift in Time, Change Time Interval, Irregular to Regular, 
Regular to Irregular, To Irregular using Pattern, and 
Extract Time Series. These functions are useful for 
manipulating time series, which are frequently necessary in 
the field of hydrology. The Irregular to Regular and 
Change Time Interval functions were evaluated in this 
study. The Irregular to Regular function was discussed in 
detail in Section Dealing with regular- and irregular-
interval time series in the HEC-DSSVue.  

Editing and exporting datasets 

The HEC-DSSVue provides functionality to edit 
datasets directly within tables. Once the Pathnames of 
interest have been selected, users can access their datasets 
by clicking the Tabulate button and then navigating to Edit 
→ Allow Editing or to Edit menu → Tabular Edit. In Figure 
6, readers can visualize five Pathnames simultaneously in a 
table in the edition mode. In this mode, non-editable table 
cells are displayed in gray (USACE, 2024), indicating that 
users cannot edit the Ordinate and Date/Time columns. The 
records, Units, and Type can be edited easily and 
independently. These changes can be saved in their own 
Pathname under editing or saved as a new Pathname if the 
user wishes to preserve the Pathname with the original data. 

In the edition mode, functions such as Cut, Paste, 
Insert Rows, and Delete Rows are available from the Edit or 
context menus (accessed by right-clicking on the table cells) 
(Figure 6). These options allow users to modify and delete 
existing records, and include new records. These editing 
functions are essential and highly effective for refining 
datasets after importing them into the HEC-DSSVue. 
Similar editing functions are not commonly found in other 
hydrological tools, such as those described by ANA (2002), 
UFV (2008), Vargas et al. (2019), and Vargas et al. (2023). 

Users can easily export datasets displayed as tabular 
data whenever they wish by clicking on the File menu and 
then Export. In this case, the HEC-DSSVue exports in the 
form of a text file, which can then be opened in other 
computer programs, such as Microsoft Excel. Additionally, 
users can export the datasets contained in the selected 
Pathnames directly as xlsx files by navigating to Data Entry 
menu → Export → Excel (or Excel Export (Beta)), as 
depicted in Figure 7. These export commands are 
particularly useful for sharing datasets with HEC-DSSVue 
non-users who require a time series to perform hydrological 
analyses or as inputs for mathematical models.
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FIGURE 6. Illustration of five Pathnames selected and in edition mode in tabular data. 
 

 

FIGURE 7. Datasets stored in the selected Pathnames after being exported in Microsoft Excel format. 
 
CONCLUSIONS    

The main conclusions of this technical article are:  

 The HEC-DSSVue provides several useful import 
functionalities and an efficient data management 
structure based on Pathnames within a project, 
which is compatible with the needs of rainfall 
datasets. 

 Many robust commands are available in the 
software to manipulate irregular-interval time 
series, which are common in rainfall datasets, and 
to convert them into regular-interval time series.  

 The HEC-DSSVue allows users to handle multiple 
time series obtained from the same rain gage and 
group them into a single series. 

 Modelers can specify the hydrological meaning of 
the records stored in the HEC-DSSVue. 

 

 The data type (PER-CUM, PER-AVER, INST-VAL, 
or INST-CUM) dictates how the HEC-DSSVue 
commands work and interact with datasets, 
indicating that the software is optimized for 
hydrological data manipulation. 

 The software offers a broad range of commands to 
manipulate sub-daily datasets, which are common 
in hydrological analyses; however, most application 
programs do not provide such possibilities. 

 Datasets of interest can be visualized individually 
or jointly, either as plots or in tabular form, 
providing an excellent alternative for hydrological 
analysis from a regional perspective. 

 Rainfall data manipulation in HEC-DSSVue can 
be performed using many mathematical functions 
grouped by similarity and purpose under different 
tabs, particularly those available in Arithmetic, 
General, and Time Functions. 
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 Users can edit existing rainfall records, include 
new records, or delete records after importing the 
datasets into the HEC-DSSVue. 

 The export commands allow users to generate text 
and xlsx files, which are useful for sharing datasets 
with HEC-DSSVue non-users who require time 
series for hydrological analysis or input into 
mathematical models.  
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